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� ���� �������� ���� ��� ��� ����� ������ ����

�������� �������� � 18h���������� � 925h

�������� ������ ��� �������� �������� � 26h�������� ������ ����� ������� � 109h

��������������� � 38h����� ������������ 118h

������� ���� � ������ � 410h����� ����� ������ � 128h

���������� ������� � 520h��������� ���� � 1310h

����������� ������������ ����������� ����������� �  6
(PLD � ��������)

8h���������� ������ � 1410h

PIC 16F84A ������� ������� � 710h������ ������ ���� � ����� � 1530h

������ ����� � 810h

�� ������ ����� �������� ��� ������
����� ����� ��������������� �������� �������� POWER POINT ����������� ���������� �

. ������ �����������������
. ���������� ������� ������ ������ ������ PSPICE ���������

�������������� ����� �� ����������������������� ���� ������PCBOARD ������� �
PSPICE

������� ��� ������� ��������������� ����� ��������� ��� ����������������� ���������� �����
� ������ ������ �������� ����

www. als design . fr��downloads��eval. html

www. cadence. com��products�oracad�dowloads��pspice ��schcmatic��in dex . aspx

www. engr . u ky . edu��~�cathey�pspice061301. html

�� �A ������ ���������� ������� ��� �������� �������� �������� ��������������� ������� ������
. �B ������

������ ��� �� ���������������� ��� �� ������������� PIC16F84 ������ ���������������������
�������� ����������� �� ��������� �� ������� ������� ������������������ ����� �����������

MICROCHIP �� MPL� AB �������� ���������������� ��� ��

. ICPROG�������� ������� MPL� AB ������ ������ ������ ������ ����� �� ���� ����
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�A������
����MICROSIM-PSPICE������������������A

����������1.A
�����������1.1.A

��������������������������������������������������������MICROSIM-PSPICE���
��������������������������������������������������������������������������������������������

.����������
����Démarrer������������������������Windows���   �������������
����������������Design�Labo Eval 8�������������������������Programme����

.��Schematics�����������
��������������������������������

.�����������
.������������������

.���������������������
.����������������������������������������������

������������������������2.1.A
1.A������������������PSPICE������������������������

 Créer un nouveau schéma ( création de
répertoire et fichiers )    Editeur de symboles

 Ouvrir un schéma existant ( la recherche
est guidée ) SIMULATION

Enregistrer le fichier ouvert courant  Définitions des directives
et types d'analyses

 Enregistrer (un élément sélectionner ou
une sélection d'éléments )

 Lancement de la
simulation

Imprimer le fichier ( ou la sélection
 Couleurs des

 marqueurs ( signaux
visualisé  sous Probe)

 Copier (un élément sélectionner ou une
sélection d'éléments )

 Placement d'un
 marqueur tension /

courant

Imprimer le fichier ( ou la sélection

 Copier (un élément sélectionner ou une
sélection d'éléments )
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Rafraîchir l'écran  Validation de
 l'affichage des

 tensions du point
 de départ ou de

 repos sur le schéma
 / suppression de

l'affichage

 Couper, supprimer ( un élément
sélectionner ou une sélection d'éléments )

Annuler l'action précédente  Validation de
 l'affichage de courants

 du point de départ
 ou de repos sur le

 schéma / suppression
de l'affichage

Répéter l'action précédente

 Zoom moins ( diminution en taille des
éléments de la fenêtre courante

 Zoom plus ( agrandissement en taille des
éléments de la fenêtre courante )

Zoom de la fenêtre sélectionnée
 ( apparition plein écran de la fenêtre ) ANNOTATIONS

 Affichage plein écran du schéma
complet.) Tracé de courbe

 DESSIN Tracé de rectangle

.Tracé des fils /des bus Tracé de cercle

 Edition des blocs de sous schémas (la
forme courante apparaissant est fiable ) Tracé de segment de droite

 Recherche et capture d'éléments ou
symboles issus des bibliothèques Insertion d'images

Editeur d'attributs
 Insertion d'une fenêtre
 de texte et choix de la

police du texte

PSPICE������������������������������1.A��������

Annuler l'action précédente
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��������� ������ ����������� 2.A
����� �������� ������ ������� ��� �������� ��������� Schematics � ���������� �������

.��������
� ������ ��� ���� �Drawtext » ABC�� ����� ���� ��� ������

��������� �
������� ������� ����� �

. � Save as � ����� File � ������ ������� ����������������
������� ���� �Nom. Sch� ���������� ������� �������� ��Nom � ������� ��

��Enregistrer � �� ������� ����� .������ Répertoire ��������� � Dans �
��������

.��File � � � Save � ������� ��� �� �� ����� ��� ��������� ���
� (Gets)�������� ����� 1.2.A

Get � ���� ������� �� � Get New Part » ��������� ��������� Draw � ���������������
������������� ��������� ������� ������ .������� ��� ��� ������ � New Part
��������� ������ � Advanced basic � ���� ������� .������� �������Gets�

.��Advanced � �� ��� �������� ����� ���
�� ���� �������������� ���� ���� ���� ���� ��������� ���� ���*

.� Part Name � �������
�� �Place ������� ��� ����� �������� ���������� ����������� ������ ����

.���� ��� ����� ��� �� .����� �������������
������ ���������� ����� �������� �������� ����� ��� ����� ���������

.������ ����� ���������� ��
.������ ������� Supp�� ���� ��� ���� ������������� ����� ��

.�� Rotate � ��� ����� �� � Edit � ������ ��� ����������������� �
.« Flip � ��� �������� � Edit � ������ ������� � Miroir ������ ����

��������
.�������� ��������� ���� ���� ����� ������ ����� ������� �� �

��� ������������ ��������� ����� ����������������� ������������������� ������ �
.������ ����� ����������� ����� ������
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��������
Gnd ������ OV������ ���� ��� ����� �� ������������� ��� ��������

.�Gnd Earth ���Analog Gnd������������� ��� ���� �Ground ��
������������ ������������� 2.2.A

����� « Draw � ��������� ��������� ����������� ����� ������������� ��������� �������
.��� ���� ������ ���� . « Draw wire» ����������� ������ �� « Wire �

�������������� 3.2.A
.���� �� ���� ��������������� ���������� ���

��������
.������ k1 � ���������� R1 ������� ��� �� �

����� ���� ���������� ��� 7400 � ��������� �������U1A ����������� ���� ������ ����� ��
�NAND

��������
������ ����� � ������ ������� �� �������� Stimulus � �������� ������ ������ ��

.��������� ��������
.������ � ������ �� ���� ��� ����� � �������� ������� ���

�������� ���� ��� ���� ����
���������� ���� ��������� ������� *

������ ���� ���������� ������� �������� ������ �� �������� ��� ������� ����� ������
.������ ����������������� ������ �����

��������� ������� *
��� ����� ��� � ������ ����� ������ ���� �������� ����� ���

Pkgref �� � ����� ���� ��� Value � ������ ��������������������� �������
������ ����� ����

�������
�� ��� ��� ������� � �Value � ��� ��� ����� �� ������� ��������������
����������� . ��Save attr�� ������������������������������� ��� �� �����������
.OK ���� ���������� ��� � ������� ��� ����� ����� Pkgref . ������� �����
������ ���� ��� ����� ��� ����� .����� ��� ���������� �������������� ��� ���

.����� ���������� �� ������ ��� � ���� �� ����� � ������ �� ������� ����� ����
. ������ �������� � ������������ ����������� ����������
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��������� �������� �� ��� ������������������ �� �������� ��������� ��������
��� �������� s�� ������� �Henry������ H���������� �Farad �����������F �������
�� ���� � ����� ��� �� ����Ω� ����������� ��� �� ������ ��� � ��������� �������

.PSPICE ������
��������Label� ���� ������������ �� � ���� ���� ���� ������ �� ����

.������� ����������
���� �������������������� ����� ��� ������ ���������� ���� �������� �

. ������� ���
. ������ �� �������� ������ �Labels) �������� ���� �

�������� ������� ������ 3.A
����� �������� ������ �������� .�������� �������� ������� ������������ �������

���� �������
. � Transient Analysis � ������ ����� ������ �� ������ ������� �
��AC Sweep � ������� �������������� �� �������������� �

�� � Set up » ������ �� ��Analysis������� ��������������� ���������� ������ ���������
. ����� ���� ������ �� ����������� �� ��Set up Analysis � ����������

. ������ ������� �� ���������������� �������������
�������

������� � Transient�� ���� ��� ����� ����� Transient�� ������
������������ ��� ���� ������� ��������������� � Print Step � �������� ���� �

. ������� ��� �� ��� ��� 10000 � 1000

. ������� ���������� ������������ ������ Final time�� ������� ��� � �
� �������� �������� ������� 4.A

����� ������ ����� �Microsim probe ������������ ������� �� Simulate � �������� ������
. � Add � �� � Trace � ������ ���� �������� ��������

������� �� �������� ������ ����
. ������ ����� 1 �� 0������� ������� ������� �� ������� ������ �

.������ ����� ������� ��������������� ������ �
�� �� �������� ������ �� ������� ��������������� ��������������� ����������� ����������
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��������������� ���� ������������� �������� ���� ������ �������������� �������
. ������� ������ ����� � �����

Toggle� ���� �� � Cursor � �� � Tools�� ������ ���������������������� ��� ���
.�������� ����� ������ ������ ��� ����� ������ ���� ������ � Cursor

����� ������ ��� ��� ��������� �������� ���� ������������� �������� �������
�� ���������� ������������� ��������� ���� ����� ��� Voltage�� Analog������� ���������
����� ������ ������� ����� �������� �������� ���� ������ ��� �����������������

. ������� ������ ������
���� ������� ������ �� ���� ����� �� ������� ����� ��� ����������������� ��
���� ����� �� ������� ����� ���������� ����������� ���� ��� ������� ���� ��

. � Mark Label�
��������

������ Vs�� Ve����������������������� Vs = f(Ve)���������� ������� ������ ���������
Axis ������ ��� ����� � X Axis Settings ���� « Plot � ������ ����� �������
.��� ������������� ������� ����������������� ������� ������� �� ��. Variable

. ������� ��� �� Voltage � Analog ������ ��� ���� ����� �� ������ ����
.������������������V�Ve������ �Ve �� X ���� �� ��� ������ ��

. ������ ����� ����������� ����� ����� ��� ��������� ����� ����� ����
�������� ���������� ��������������� ���� ����� ��������� 2.A �������������

. ����� ����� ��� �� PSPICE
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PSPICE ������ �������� ������������� ����� ������ �2.A ������
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B �����
MICROSIM – PC BOARDS � �������� ������� ������� .B

����������������� ����� ������ �PSPICE ����� ���������� ��������� ������ � ��������
.PC BOARDS �������� ������ �������

PC BOARDS�� �� ������� ����� ������ 1.B

����� ������������������������������������������� �PSPICE �� ��� �������� ������
�� ������ ��������� �������� ��� ������������ � SIMULATION ONLY� �������� ����������
��� ��� ��������� .��� ���������������� ���� �������� ������� ���������������

.��� ���� ���� ���� �Jump� ������� �����
�����

�Jump1� ������������ Vcc������� ���� �
�Jump1� ���� ������� GND������� �

�Jump2� ���� ������� niV ����� ����� �
� �Packaging� ����������� �������� ����� 1.1.B

������� �� ������������ ���� ������������ ���� ��� ���������� ���������������
����� �� ������ ������ .����� ��� ������ ������� ������ ���� ������ ����� �������
PKGTYPE������� ��������� ������ �������������� ����� ���������� ���������� �������
������ ��� �����.� ������� 14 ���� �D1P14� PKGTYPE� Dual Inline Package ���������

������ ���� ����� ���� ����� ����� ��������� ����� �������
PSPICE ��������Tools�→ Package → OK�

Net list������ ������ ������ 2.1.B

������ ��������� ���� �������� �� ����� ����� ������ ��� ��� ���� �����
���� .������ ����� ������� ������ ������� �������� ��� ���� .���������� ���������

� slooT�→�Create layout net list�→ OK ���� ����
����� ���� ��� ����� .������������ ������ ��� ������� � ����� �������� �������
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SIMULATIONONLY ���� �� ������
PC Board� ��������� ������ 3.1.B

��������� PC Board��������� �������� ����������� �������� �������� ��� �� ����
���������� ������ � ����PCSPICE ��������� Tools → Run PC Board→ yes

. �1.B����� ������� ���� ������������� PC Board ����

PC Board ������������������������ �1.B������
���� ��� ����� ��.pca� ������� ��� ���������� ������ ��� ������ �����������

.����� ������ �������
��������������� 2.B

������������ ���� ��inch����������������� ������������ ����������� ��� ��������
.option �mm� ��� �������� Tools →�option �������

��� ����� �������������� ���������� ������ ������ ������� ������ ��� ������ ������
��� ������������� ������ ������� ����������� �������� ������ ����������� ������� ��routage�
������ ����� �� �� ��������� .������������� ��� ��� ��.���������� �������
������� ������� ����� �������� �������� ����� �� ����� ���� �������� ��

. �CTRLM� ����� ���� ��CTRLR� ��������
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��������
����� ��� �� .����������� ��� ����� ����� ������������ ����������� ���
����� �� ���� ���� ��� ��� ����������� �������� ����������� ������ �

.Jump ������ ��� �������
��� ������� ��������� .������ �� ��� �� ���� ������ ����������� ������ ������
��� ����� ������.���������� RATS ����� ���� ���� ��� ��� ������������
��� ��������� Tools→�Optimize Rats ���������� ����������� ����� �����������

.����� ����� ��� �� ���� ������

������ �� ������ ������ ����� �Optimisation� ���������� ��������� ������� ��������
��� �������� ���� ��������

. Tools�→Option ��� Option →Optimize Rats� �
��������

������ ������ ��� ������ ��� ��������� ������� ���������� ���� ��� ��
�������� ���� ��egatuor� �������� ��������� .������ ���� ����������� ������ ���
���������� ��� ����� ����� ��� ����� ��� ���� ����� Jump ���������� ��������

.VIA� PADSTACK ������ ����� � ������ ������ ���
� �routage automatique� ����� ������� ������ B .3

Draw→ Board signal keepin ������ ������� ������������� ����� ��� ���
��� ������ ����� ������� ���� ������� �routeur� �������� ���� ���� ��������

.������
�������������� ������ ������ ������ ���� ����� ��� ������������� �����
������ ������ ����� ������������ ���� ������ ��� ����� .�������� ����� ���

.����������� ������������ �Draw →�Keep out� ���
������ ���� ���� �������� ��������� ���� �������� ����� ��� ���
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�� ����� ������� �width� �������� ����� ��� ������� Tools→ CCT � Setup

�������� ������ ��� ������ 1�27mm � 0�645mm ��� �clearance� ������
.OK ��������

������� ������� ��� ����� ��� ��� ��� � CCT � Net rules →Tools ������
.������ �� ��������� ������� ��� ���� �� ���� ���������� ����

�DFM→Mitter Bends→ Set Default�Mitters� �������� ������������� ����
.����� ������ ���������� � �������� ��������� ������ ���� ����

Tools→ Autoroute������ �������������������� ������� ���������������� ���
����������� ����������� 2.B��������� ��� .spectra ���� �������� ������� ���� �������

.�������� �����

��������� ������ ���� �������� ������� �2.B������
.������� ��� ��� ��� ��� �� ������

�File→ report→ Bill off Materials� ������ ���� ������� �����
Configuration.����������� ��� ��������� ������� ��������� ���� ��� ��������
������� �� ������ ������ ���� �Job������ �� ���� �� ����� ��� ��� ��������

������ ���� ���������������� �� ����� ��� ����
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File�→�Job setup�→�New�
��������������� � ����������� ������ ������� ������ �����A4 ���������� ������� ���������������

��������
Plot origine x � �100mm� �� y � 150mm → OK

Definie page ��3.B������������������������� 1������� ��������� ��� ����
�������→ New

Board signal keepin et solder

������ ���� �������� ���������3.B������

������� New �page ����������� ���������� �������� �2 ������������� ������
�4.B������ ��Board signal keepin → OK → OK � �������������� silktop

���������������������� ������� �4.B������

���� ��� ���
File → Print → New Job �Print�→ Print the job
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C �����
Pic aff.asm���� 1.C

���� ��� ���� ���������� ���� ���� ������ �������� ��

�Horloge � �

��Affichage � Heures� minutes� la secondes clignote��
��Réglages � Raz des secondes� Réglage des Heures� des Minutes� Reset
��Interruption provoquée par le timer ‘temps réel’
��Comptages des inters Quartz 4096KHz �Fe�1024kHz�
� Prédiviseur par 32
��Le débordement du timer provoque une interruption toutes les 8ms
��Il faut 125 interruptions pour faire une seconde
�
�������������������������������������������������������������������������

�
� � �

�Configuration du pic� des registres et appel des macros
config cp�non� pwrt�non� wdt�non� osc�xt
�Les constantes registres include �registres.h� �
�Les macros include �stdmac.h� �

�Définition des constantes
�Cte du Nb d’inter pour la� equ d’125’� CTinter
seconde�1�8ms�
�Cte de la fréquence de comptage du equ d’40’ CTreglage
réglage

�Cte valeur max de comptage modulo 60 equ d’60’ Max60
�Cte valeur max de comptage modolo 24 equ d’24’ Max24
�Cte valeur max Unités de conversion equ d’10’ MaxUnite
Bin�Bcd

�Cte RB4 commande de l’aff1.�le ��à droite� equ h’10’ Aff1
�Cte RB5 commande de l’afficheur 2� equ h’20’ Aff2
�Cte RB6 commande de l’afficheur 3 equ h’40’ Aff3
�Cte RB7 commande de l’aff4.�le ��à gauche� equ h’80’ Aff4

�Cte bit RA0��Raz des secondes �le ��à gauche� equ d’0’� ToucheRA0
�Cte bit RA1��réglage des minutes equ d’1’ ToucheRA1
�Cte bit RA2��réglage des heures� equ d’2’ ToucheRA2
�Cte bit RA3��Reset �le � à droite� equ d’3’� ToucheRA3

�Cte bit RA4�PORTA� equ d’4’ SortieRA4
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�Réservaton des variables
0x20�zreg �zone registre libre �usage général� org �

�Var. Comptage des interruptions du 1 rm NBinter
timer
�Var. pour la tempoReg 1 rm NbTempoReg

�Var. compteur des secondes 1 rm� Secondes
�Var. compteur des minutes 1 rm� Minutes
�Var. compteur des heures 1 rm� Heures

�Var. octet à convertir pour les aff. 1 et 2� 1 rm DataAff12
�Var. octet à convertir pour les aff. 3 et 4� 1 rm DataAff34

�Var. 4 bits pour l’afficheur 1 �le � à 1 rm � Aff1Data
droite�
�Var. 4 bits pour l’afficheur 2 1 rm Aff2Data
�Var. 4 bits pour l’afficheur 3� 1 rm Aff3Data
�Var. 4 bits pour l’afficheur 4 �le � à 1 rm � Aff4Data
gauche�

�Var. octet à convertir en BCD rm  1� Bin
�Var. unitée BCD convertie 1� rm BcdUnite
�Var. dizaine BCD convertie 1 rm BcdDizaine
��������������������Début du programme après reset������������������������
�
�Reset toujours à l’adresse 0� 0�zprog org� �
goto Init �
� � � �

�����������������������Programme d’interruption���������������������������
�Inter toujours à l’adresse 4� 4�zprog org� �
� � �
�Décrémente à chaque inter pour seconde decfsz NBinter �
�Si NBinter pas 0 alors suite � Suite goto �
�Si NBinter�0 alors on compte� Compteur� call �
� � � � � �
��Initialisation du CTinter�NBinter movlf �

compteur CTinter
� �
�Drapeau d’inter à 0 � INTCON�T0IF bcf Suite
�Retour au programme principal � retfie

�Compteur Secondes�Minutes�Heures.
Secondes incf Compteur

�Secondes�Secondes�1
��Si Secondes�Max60�RazSecondes beqc �
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Secondes�Max60
�alors on va à RazSecondes sinon retour return �
� � � � � � � � �
�Raz Secondes � Secondes� clrf RazSecondes

Minutes incf RegMin
�Minutes�Minutes�1
��Si Minutes�Max60�RazMinutes beqc �
Minutes�Max60
�alors on va à RazMinutes sinon retour return �
� � � � � � �
�Raz Minutes � Minutes� clrf RazMinutes

Heures incf RegHeur
�Heures�Heures�1
��Si Heures�Max24�RazHeures beqc �
Heures�Max24
�alors on va à RazHeures sinon retour return �
� � �

�Il est minuit con � Heures� clrf RazHeures
� � return� � �

��������������������Programmeprincipal�����������������������������������
�initialisations
�passer en page 1 �accés à TRIS et STATUS�RP0 bsf Init
OPTION�

��Tout PORTB en sortie� TRISB clrf � �
��RA4 en sortie� le reste TRISA�SortieRA4� bcf �
en entrée
��1��RBPU���0��PS0���0��PS1���1��PS2� �pas de� movlw �
pull Up
��sur port B et timer � OPTIO movwf �
prédiv�32
� � �
�Repasser en page 0 STATUS�RP0 bcf� �
� � �
���1��T0IE���1��GIE��Validation locale et globale movlw� � �
��pour autoriser l’inter INTCON � movwf �
timer

� � � movlf CTinter�NBinter �Init du décompte des 
inters 
�Raz des variables Secondes clrf �
Minutes clrf �
Heures� clrf �

�Boucle du programme principal
�Détection touches clavier� call DetecteTouches Boucle
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�Chargement des Données à afficher
��Chargement des movff Minutes�DataAff12�
données
�à afficher movff Heures�DataAff34
�Conversion Bin�Bcd ConvertAff� call
� � �
�Affichage multiplexé
�Affichage multiplexé Affiche� call
�La sortie clignote à la seconde ClignoSortie call �
�On reboucle Boucle     goto �
� � �
������������������������Sous programmes���������������������������������
��
�Traitement des valeurs à afficher � conversion et stockage

�On charge la valeur à convertir� DataAff12�Bin movff ConvertAff
�Conversion Binaire�Bcd BinBcd call �

����Envoi des valeurs Bcd BcdUnite�Aff1Data movff�
dans les
BcdDizaine�Aff2Data �registres d’affichage movff
� � �
�Pareil que pour les secondes� DataAff34�Bin� movff
BinBcd� call �
BcdUnite�Aff3Data movff
BcdDizaine�Aff4Data movff
return �

�Conversion Binaire�BCD dynamique �max � 99� 2 chiffres�
�Raz de la variable Unite� BcdUnite clrf� BinBcd
��Raz de la variable BcdDizaine clrf �
Dizaine
� � �

� Bin�W movf � Bcl
�Si Bin ��0� on retourne � skipz �
�Sinon IncBcdUnite� � IncBcdUnite goto �
� � return� � �

�BcdUnite � BcdUnite�1 BcdUnite incf� IncBcdUnite
��On décrémente Bin Bin decf �
�
��Si BcdUnite�MaxUnite�RazBcdUnite beqc �
BcdUnite�MaxUnite
��on va à RazBcdUnite�� Bcl goto �
sinon Bcl
� � � � � � � � �
BcdUnite �Raz � BcdUnite� clrf RazBcdUnite
��BcdDizaine BcdDizaine incf �
� � BcdDizaine�1
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Bcl goto �

�Affichage multiplexé
�On charge la donnée Aff1Data�W movf Affiche
quartet bas
��On charge l’afficheur Aff1 iorlw
quartet haut
�On envoie PORTB PORTB movwf �
�� �On temporise T1mS call � �

� �
�Pareil... Aff2Data�W movf
� � Aff2 iorlw� � �
� � PORTB movwf� � �
� � T1mS� call� � �

�Pareil... Aff3Data�W movf
� � Aff3 iorlw � �
� � PORTB movwf� � �
� T1mS call � �
� � �
�Pareil... Aff4Data�W movf
� � Aff4 iorlw � �
� � PORTB movwf� � �
� T1mS call � �

�Tempo pour les NbTempoReg movf� TempoRgl
réglages
��On répète CTreglage fois skipz �
l’affichage
��et du coup� ça ralentit � goto decreme� �
return �

NbTempoReg� decf decreme
goto Affiche

�Clignotement de la Sortie RA4 à la seconde �F � 1Hz�
�Seconde dans W � Secondes�W� movf ClignoSortie
�On ne garde que le bit 0 1 andlw� �
�Si 0 alors SortieRA4�0 � ClrRA4 bz �
�Sinon SortieRA4�1 et voila � SetRA4 goto� �
� � �
�Sortie�1 PORTA�SortieRA4 bcf ClrRA4
return �

�Sortie�0 PORTA�SortieRA4 bsf SetRA4
return �

 ww.physique48.org


2425

�Détection des touches
�Raz des Secondes ou suite PORTA�ToucheRA0 btfss DetecteTouches
� � RazSec call� � �
� � � � � �
PORTA�ToucheRA1 �Réglage minute ou suite btfss �
� � RegHeures call� � �
� � �
�Réglage heure ou suite� PORTA�ToucheRA2 btfss �
� � RegMinutes call� � �
� �
�Reset ou return PORTA�ToucheRA3 btfss �
� � Init call� � �
� �
return �

�Réglage de l’horloge
Secondes clrf RazSec
return �
� � �
CTreglage�NbTempoReg �Init. de la tempo de reglage movlf RegMinutes

����Réglage des minutes RegMin call �
return �

CTreglage�NbTempoReg �Init. de la tempo de movlf � RegHeures
reglage

����Réglage des heures RegHeur� call �
return �

�Temporisation logicielle pour le multiplexage

��Fichier des Tempo include �Tempo4.inc� � �

������������������������������Fin������������������������������������������
�
�Fin du programme end �

pic�ad.asm��� 2.C�
�� ��� ��� ��� ������� ������������������� ����� �����������

� � �
� � � ��Programme Conversion Analogique Numérique 
��La tension Analogique d’entrée est comparée à la tension de sortie
��du Convetisseur Numérique Analogique R�2R 8bits  placé en sortie de PORTB 
��La sortie du comparateur est envoyée sur l’entrée RA4 du PORTA

�Configuration du pic�des registres et appel des macros  
� � � config cp�non� pwrt�non� wdt�non� osc�xt
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� � � include �registres.h�
� � � include “stdmac.h”

�Définition des constantes
CTtempo  equ 30   
BitRA4  equ 4
�
�Réservaton des variables 
� � � org 0x20�zreg �zone registre libre �usage général�

NbTempo  rm 1 �Var. pour la tempo 
NbTempo1  rm 1 �Var. pour la tempo1

�������������������le programme principal commence ici ������������������

� � � org 0�zprog  �Reset toujours à l’adresse 0

��Initialisation

Init  bsf STATUS�RP0  �Passer en page 1
� � � clrf TRISB   �PORTB en sortie
� � � bcf STATUS�RP0  �Repasser en page 0
� � � � �
��Boucle du programme principal

Boucle  btfss PORTA�BitRA4 �RA4 est il à 1 �
� � � goto Incremente
� � � goto Decremente
� � �
Incremente incf PORTB   �PORTB�PORTB�1
� � � call T1mS
� � � goto  Boucle
� � �
Decremente decf PORTB   �PORTB�PORTB�1
� � � call T1mS
� � � goto Boucle
� � � � �

�Temporisation logicielle   
� � �
� � � include �Tempo4.inc�

� � � end

� �chenillard.asm ��� 3.C 
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� � ��� ������� ������� ������ �����������������
��Programme chenillard sur le PORTB le sens est dépendant de RA0 et RA3
��La vitesse de défilement dépend de RA1 et RA2
�
�Configuration du pic�des registres et appel des macros  
� � � config cp�non� pwrt�non� wdt�non� osc�xt
� � � include �registres.h�
� � � include “stdmac.h”

�Définition des constantes
CTtempo  equ 100   
B0   equ 0  
B1   equ 1
B2   equ 2
B3   equ 3
SensBit0  equ 0
�Réservaton des variables 
� � � org 0x20�zreg �zone registre libre �usage général�

NBtempo  rm 1
Vitesse  rm 1
Sens  rm 1

�������������������le programme commence ici ������������������
� � � org 0�zprog  �Reset toujours à l’adresse 0

��Initialisation

Init  bsf STATUS�RP0  �Passer en page 1
� � � clrf TRISB   �PORTB en sortie
� � � bcf STATUS�RP0  �Repasser en page 0
� � � clrf PORTB   �Tout PORTB à 0
� � � bsf PORTB�0  �Bit 0 du PORTB à 1
� � � movlf CTtempo�Vitesse �Initialisation de la 
Tempo
� � �
�������������la boucle chenillard avec le test des touches����������������
�Sens de défilement
�Bascule SR mémorisant le sens de défilement �bit 0 du registre Sens�
TestRA0  btfsc PORTA�B0  �RA0 est il à 0 �Bouton 
B0 appuyé��� � � � �
� � � goto TestRA3  �Si oui alors le bit 0 du 
registre
� � � bsf Sens�SensBit0 �Sens est mis à 1 �Set�
� � �
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TestRA3  btfsc PORTA�B3  �RA3 est il à 0 �Bouton 
B3 appuyé��
� � � goto TestSens  �Si oui alors le bit 0 du 
registre
� � � bcf Sens�SensBit0 �Sens est mis à 0 �Reset�

�Test du Sens de défilement
TestSens  btfsc Sens�SensBit0 �Test du bit 0 du registre Sens 
� � � goto Gauche   �Si 1 alors défilement à
gauche   
� � � goto Droite  �Si 0 alors défilement à droite

Gauche  rlf PORTB   �Rotation à gauche
� � � goto RegleVitesse 

Droite  rrf PORTB   �Rotation à droite

�Réglage de la vitesse
RegleVitesse btfsc PORTA�B1  �RA1 est il à 0 �Bouton B1 
appuyé��
� � � goto TestMoins  �Si oui alors incrémente 
vitesse
� � � � � � � �Si non alors TestMoins
Plus  incf Vitesse
� � �
TestMoins  btfsc PORTA�B2  �RA1 est il à 0 �Bouton 
B2 appuyé��
� � � goto Temporisation �Si oui alors décrémente vitesse
� � � � � � � �Si non alors on 
temporise 
Moins  decf Vitesse
� � �
�Tempo ��Vitesse X Temporisation logicielle
� � �
Temporisation movff Vitesse�NBtempo �Initialisation de Tempo
Attente  call T1mS   �Tempo base de temps
� � � decfsz NBtempo �Décrémente le NBtempo jusqu’a 0
� � � goto Attente  �Si pas 0 alors Attente
� � � goto TestRA0  �Si 0 on reboucle 
� � � � �
�Temporisation logicielle �fichier importé� � �

� � � include �Tempo4.inc�� �Fichier des Tempo

� � � end
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